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You may not reproduce, transmit, transcribe, store in a retrieval system or translate into any 
human or computer language this manual and software. These actions, in any form or by 
any means, are illegal without the express written permission of Puritas Springs Software. 
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During the period of time before a major upgrade, if the disks that make up the then-current 
version of this software are defective, then return the software to Puritas Springs Soft-
ware, 645 McKee Trail, Hinckley, Ohio 44233-9209 and replacement disks will be mailed to 
you. Puritas Springs Software reserves the right to define and decide what constitutes a 
major upgrade. 
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Puritas Springs Software provides Family Law Practitioner's Apprentice—Version 2+ 
(FLPA2), consisting of both the software and this manual, "AS IS." The software and man-
ual carry no warranty as to performance, merchantability or fitness for any particular use. 
Puritas Springs Software specifically disclaims all warranties, express or implied, regard-
ing the software or our services, and Puritas Springs Software does not warrant that the 
software or services are free from defects, interruption, errors or other program limitations. 
For states containing limitations on implied warranties, any such implied warranties are lim-
ited to 60 days from the date of purchase. The rights provided by this Limited Warranty shall 
be limited to the original, registered and recorded purchaser of the software. Said rights are 
limited to the cost of the software and are non-transferable.  You assume all liability and re-
sponsibility for the accuracy of any form produced by this software. Recognizing this, Puri-
tas Springs Software has exercised due care in the preparation of the software and man-
ual. In no event, however, shall the authors or publisher be liable for direct, incidental or 
consequential damages, or damages of any type, arising from the use of FLPA2. 
 
This Agreement sets forth Puritas Springs Software’s entire liability and your exclusive 
rights and remedy with respect to the software. Headings are included for convenience and 
shall not be considered in interpreting this Agreement. This Agreement does not limit any 
rights that Puritas Springs Software may have under trade secret, copyright, patent or 
other laws, federal or state. 
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Puritas Springs Software's Family Law Practitio-
ner’s Apprentice—Version 2+ (FLPA2) is an ordi-
nary 32 bit Windows program that runs on Windows 
Vista, Windows XP, Windows 2000, Windows ME, and 
Windows 98. FLPA2 comes in different versions for single-user and network instal-
lations. You can assume that, unless you specifically purchased a network license, 
yours is the single user version. 
 
United States Copyright Laws protect FLPA2 as the intellectual property of Puritas 
Springs Software. Your FLPA2 distribution disk contains a registered serial num-
ber. Possessors of unauthorized copies violate Federal Law. 

 
The topics below give you basic information about window components and techni-
cal information concerning the installation process and networks. In all likelihood 
you already know the Windows basics, and you may not need any other technical 
information, but it’s here for you if you need it. 
 
Window Components 
 
Most Windows programs appear in a window. A "window" is nothing more than a 
rectangle on your screen that contains a running application. Each window has sev-
eral parts—a title bar containing the name of the Windows application, a menu bar 
with drop down menus containing various commands, a tool bar with buttons for 
common operations, and a client area where documents or other information are dis-
played. Each of these windows components is explained below. 
 
• the title bar is the top line of the window; it displays the program call letters—

FLPA2—and adds the name of the file currently loaded and the particular form 
at which you are looking. A typical title bar example might be: 

 
 FLPA2: Smith, James H—[General Information Worksheet] 
 
• the menu bar is directly under the title bar; from left to right, the drop-down 

menus are: File, Worksheet, Document/Form, Options, Window and Help. 
There is also a menu that appears when any one of the six database worksheets is 
on the screen. The individual database worksheet menus take the name of the 
database (Child, Third Party, Asset, Debt, Income and Expense) and contain 
a set of commands specific to the database worksheets. Note that the underlined 
characters in the menu indicate that holding down <ALT> together with the un-
derlined character will pull that menu down without needing to use your mouse. 

 
• The tool bar is directly under the menu bar. It contains buttons that let you exe-

cute certain, oft-used commands without navigating the menu system; from left 
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to right, the buttons perform the following functions: create a new client file, 
open or load a client file from disk, save the currently loaded client file to disk. 
The next six buttons display the database worksheets: Child, Third Party, As-
set, Debt, Income and Expense. The last two buttons close the active window 
and exit FLPA2 respectively. Note that the function of any button can be ascer-
tained by letting the mouse pointer remain stationary over the button. A help 
hint will appear. There are a few buttons that only appear in certain contexts. 
There are Print This Form and Send To Word Processor buttons that appear 
when static forms are on your screen; there are paging buttons that also appear 
when the static forms are multi-page. 

 
• the client area is the large portion of the window where you see your worksheets 

or where the Document Wizard appears. 
 
Technical Information 
 
Your client information is contained in a file that has an FL2 extension and contains 
the following: 
 
1. The General Information Worksheet;  
2. The 6 database worksheets;  
3. Information directly entered on static forms; and 
4. The information you enter into the various Document Wizards.  
 
IMPORTANT NOTE: For most documents, 
FLPA2 does NOT display or allow you to edit 
them. FLPA2’s basic function is to generate a 
complete document and send it to YOUR 
WORD PROCESSOR. It stores these com-
pleted documents as rich text or RTF files in 
the following directory: 
C:\Puritas\FLPA\Files\RTF\. When you click 
on the Finish button in the Document Wizard, 
it automatically saves the RTF file using a com-
bination of the file name and the document 
name separated by a hyphen, i.e.: 
 
Smith, Joseph M—Divorce, Complaint for.RTF 
 
Once the document is in your word processor, you can, of course, resave the docu-
ment using any name you choose. In addition to saving the RTF file, FLPA2 auto-
matically starts your word processor and opens the completed document. Again, 
once you are in your word processor you can do whatever you want—change the 
name of the file, edit and print it, save it in a different location or save it as a differ-
ent file type, ie., DOC for Word or WP for WordPerfect. 
 
When we ship FLPA2, it defaults to using Microsoft’s Word for Windows as its 
word processor. We do this because Microsoft created the RTF standard and, in our 

! 
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experience, Word handles RTF files the best. However, any Windows word proces-
sor capable of opening a rich text format file (RTF) can be used via the Options 
menu's Set Word Processor command. Consult the help file’s related topics for 
additional information on these issues. 
 
A good thing about storing your files the Files folder is all your client information 
and completed documents are in one location that is convenient for organizational 
and backup purposes. This location can be set on the Options menu and therefore 
opening and saving your FL2 files is automatic, quick and easy. The other important 
location is the RTF subfolder of the Files folder. It contains all your completed 
word processing documents. Of course, once the completed document is assembled 
and transferred to your word processor, you can save it anywhere you want. Con-
sider however that there may be an advantage to having all your RTF documents in a 
single location. 
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In General 
 
Install Family Law Practitioner’s Apprentice—
Version 2+ (FLPA2) to your computer by following 
the steps outlined in this section. Before starting the 
installation, note that the files on the distribution compact disk (CD) are compressed, 
and therefore, you must “install” FLPA2 to your computer rather than simply copy-
ing the files from the CD to your hard drive. For that same reason, you cannot run 
FLPA2 from the CD. You must install FLPA2 to your computer. 
 
Network Computers. FLPA2 is an ordinary 32-bit Windows program. It is not a 
“network” program in the sense that it permits simultaneous access to the same file by 
multiple users. However, FLPA2 runs on network installations so long as you 
have purchased a network license. In the case of network computers, the types and 
implementations are diverse and we cannot give network-specific technical support 
although we occasionally answer questions about FLPA2 to assist network adminis-
trators on issues involving installation and setup if you have purchased a network li-
cense. If you have installation questions or problems regarding network installation 
issues, please contact us. 
 
Installing FLPA2 
 
A.  Place the FLPA2 disk in your drive. 
 
B. On most systems, installation will begin automatically, however, if the installa-

tion wizard does not start automatically, follow these three steps: 
 
 1. Press the Start button; 
 
 2. Click on the Run item; and 
 
 3. In the Run dialog, type the command shown below. Note that the CD 
drive is not always assigned the letter “D” on all systems. You must use the correct 
drive letter for your system. 
 

D:\SETUP.EXE 
�

C.  The Setup progress meter will appear briefly until the Welcome dialog appears. 
Click the Next button to proceed with installation. Follow the standard Windows in-
stallation protocol by making sure all other programs/applications are turned off– not 
just minimized (still on your task bar), but terminated. Click Cancel if you want to 
abort installation. 
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D.  The Puritas Springs Software Licensing Agreement appears in the next dialog. 
Review the agreement and click the button labeled “I accept the terms in the li-
cense agreement.” then press the Next button to accept the terms and conditions of 
the license and continue with the installation. If you do not agree to the terms of the 
Licensing Agreement, you will not be able to continue installing the program 
 
E. Verify your user identification information and click the Next button. 
 
F. The Setup Type dialog will appear next.  Here you need to select the Setup type 
that best suits your needs.  There are three to choose from and they include: Typical 
Set-up, where all program features will be installed (This requires the most disk 
space), Minimal Set-up, where the minimum required program features will be in-
stalled, and Custom Set-up, where you choose which program features you want 
installed and where they will be installed. Recommended for advanced users. Choose 
Typical and click on the Next button to continue. 
 
G.  The Ready to Install dialog signals the end of the installation process and lets 
you verify your installation parameters. When you are sure everything is correct, click 
the Install button. 
 
H.  As installation begins a progress meter will keep you informed as the FLPA2 files 
are transferred from the CD to your hard drive. 
 
I. The InstallShield Wizard Completed dialog notifies you when the installation 
process is successfully completed. Click on the Finish button.  
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1. Download the Upgrade. 

A. Click on FLPA2’s Help menu and select Download Upgrade. 

B. In the Download Upgrade dialog box, click on the Check Availability but-
ton. Note that some systems, typically networks, may have security software 
and/or hardware in place that prohibit downloading executable files. If this is 
true in your office or you are having problems with the download, check with 
your network administrator. 

C. After clicking the Check Availability button, you may get one of three re-
sponses. 

1) You are notified that a newer version is available and the Check Avail-
ability button changes to a Download Upgrade button. Click on 
Download Upgrade button and see the file downloading. 

2) You are notified that there is no newer version available, in which case, 
you’re done. 

3) A message indicates an error, i.e., “HTTP Get Failed.” Talk with your 
network administrator or send in your disk according to our instructions 
on the Current Versions page of our web site: www.puritas-
springs.com. 

2. Remove FLPA2. First, it is important to know that removing the FLPA2 pro-
gram using Windows’ Add/Remove function will not delete or harm your 
client files. That being said, you should always back up the Files subfolder that 
contains the client files. The default path is C:\Puritas\FLPA2\Files\. 
Below are the steps for removing the prior version of FLPA2. Note that when we 
refer to “prior version” we are not referring to Version 1. 

A. Exit the FLPA2 program. 

B. Click on the Start button. From the Start menu select Settings, and then 
Control Panel. Note that in some Windows versions, you may need to navi-
gate to Control Panel in a different way. However, once in Control Panel, 
double-click the Add/Remove Programs icon. If you don’t see the Add/
Remove Programs icon, you may need to click on the Classic View link. 
 
Special Note to Vista Users: The Add/Remove icon in Control Panel is 
now called Programs and  Features in Classic View and Pro-
grams|Uninstall a program if you’re not in Classic View. 
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C. Select FLPA2 from the program list within the Install/Uninstall tab. With the 
FLPA2 item highlighted, click the Add/Remove button (Vista has an 
uninstall link at the top of the window instead, but the removal process is es-
sentially the same as described herein). 

D. When the Welcome dialog appears, click the Next button to begin the re-
moval process. 

E. The next dialog box to appear is titled Program Maintenance. When it ap-
pears, click the radio button next the Remove item, and then click the Next 
button. 

F. Remove the Program is the next dialog box to appear. The InstallShield 
Wizard will begin to remove the old FLPA2 program when you click the Re-
move button. 

G. You are notified when the removal function is complete. In the dialog box that 
appears, click the Finish button to close the InstallShield Wizard 

3. Install the New Version. The final step in the upgrade process is to install the 
new version by executing the file you downloaded. The name of the downloaded 
file is setupflpa2.exe (note that sometimes the exe extension is hidden) and 
when you download it, it is stored at C:\Puritas\FLPA2\Files\. When you find 
the file, double-click on it and follow the installation instructions described earlier 
in this manual. If you don’t know how to find the file, try following these steps: 

A Go to My Computer 

B Double-click the C:/ or Local Hard Drive icon. 

C Double-click the Puritas folder. 

D Double-click the FLPA2 folder. 

E Double-click the Files folder. 
 
In the Files folder you should see the setupflpa2.exe file. Double-click on it to be-
gin installation. 
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As you begin this tutorial, keep in mind that 
you start entering client information in 
Family Law Practitioner’s Apprentice—
Version 2+ (FLPA2) and end up with com-
pleted documents in your word processor. 
Along the way you will be working with 
two types of files. First is the client file—
the FL2 file that was described in the “Getting Started” section of this manual. The 
second is the completed document file, for example, a divorce complaint or separa-
tion agreement or judgment entry. You create a new client file together with all its 
derived documents by following the steps outlined below. 
 
Enter Attorney Information & Select Your Client 
The Attorney Information Dialog appears when you click on this step in the Main 
Window. The dialog has two functions: 

1. It allows you to enter the attorney's name, address and other identifying informa-
tion that can be used over and over from one client file to the next. The attorney 
information is not stored in the client file. Instead it is stored as global defaults 
that are used for every new file. 

2. The dialog has two representation buttons that allow you to send the attorney in-
formation to the General Information Worksheet as representative of either the 
Plaintiff/Petitioner 1 or Defendant/Petitioner 2. 

Note that you cannot use the representation buttons until you have completed the at-
torney information fields because if you haven't completed the information fields, 
there's nothing to send to the General Information Worksheet anyway. 
 
Complete the General Information Worksheet 
After you have indicated the party you will be representing in Step 1, the next step 
involves completing the General Information Worksheet. The information entered 
on the General Information Worksheet is basic information that reappears on most 
every other family law document, form and pleading in FLPA2. The information you 
enter on this worksheet transfers automatically to the other documents. A good exam-
ple is the case number. When you enter the case number on the General Information 
Worksheet, it automatically appears on every other document, form and pleading 
that contains a case number field -- and most do. That's why we consider the General 
Information Worksheet one of the first places you should enter information. You 
won't need much guidance to make your way through the worksheet. Simply tab from 
field to field and make your entries. 
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IMPORTANT NOTE : One often overlooked thing to note is that if you wish to tab 
backwards, hold the <SHIFT > key down while you tab. 
 
Naming & Saving Your File 
It's always a good idea to name your file right away, and now is as good a time as 
any. When you select this item in the Main Window, you'll see the standard Windows 
Save As dialog. This dialog has been a common and familiar Windows component 
for years. 

When you name your file it's good to keep a few points in mind. 

1. The rule of thumb about saving is - early and often. 
2. Always use the  FL2 extension. 
3. It's best to save your  FL2 files in the  Files folder located by default at: 

C:\Puritas\FLPA2\Files. 
 
IMPORTANT NOTE. Now is as good a time as any to explain the two types of files 
you will be saving when you use FLPA2: 

1. When you save a file using FLPA2, you are saving a FL2 file that contains the 
following information: 
 

• Entries made on the General Information Worksheet , 
• Entries made on the six database worksheets (Child, Third Party Defen-

dant, Asset, Debt, Income & Expense), 
• Any answers you typed in any and all of the Document Wizards; and 
• Any fields you completed on the static forms. 

 
2. When you use the Document Wizard and click on the Finish button, you are 

transported to your word processor. Any file you save at that point is an ordinary 
word processing file. 

 
The Database Worksheets 
There are six worksheets in FLPA2 that we refer to as database worksheets. They are 
different from the General Information Worksheet in that they are designed to 
manage an infinite amount of information in the same way that a spreadsheet or data-
base is used to process data records. Here are the six database worksheets: 

1. Child Worksheet - used to list the names, dates of birth, social security 
numbers and other information about the children of the marriage. 

2. Third Party Defendant Worksheet - used to list the names and ad-
dresses of parties that have control or an interest in marital property or 
property from which support obligations may be satisfied. 

3. Asset Worksheet - used to list the marital and non-marital assets. 
4. Debt Worksheet - used to list the debts of the parties - joint and separate. 
5. Income Worksheet - used to list the parties' sources of income. 
6. Expense Worksheet - used to list the parties' expenses. 
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The following comments apply to all six database worksheets. 

When you first view an empty worksheet, there's one blank record in it. You begin 
by completing that first record and then adding and completing more records as re-
quired. Here's some suggestions to keep in mind when making entries in the work-
sheet. 

• You can only enter information on the top part of the screen, the bottom half is 
for viewing multiple records, navigating, sorting, etc . 
 

• When you're done entering or modifying a record, send your information back to 
the table below by clicking the Save To Current Table Row button. Clicking 
this button takes the information on the top part of the screen and moves it to the 
currently selected row in the table on the bottom half of the screen. The hot key 
combination for performing this function is <CTRL><T>. 
 

• You can navigate, view multiple records, sort the table, and select a record for 
editing on the bottom part of the screen -- the part that looks like a spreadsheet. 

• Use <CTRL><F> to find things quickly. 

• Almost every function in the worksheet can be implemented using hot keys. 
There is a right-click, popup menu that has all the commands along with the hot 
key combinations. 

• Each of the columns in the worksheet can be resized by dragging and sliding the 
dividing bars between columns to the left to make a column smaller and to the 
right to make a column wider. This allows you to customize the worksheet for 
your particular computer monitor and screen resolution. FLPA2 remembers your 
settings the next time you use it. 

• The entire table can be sorted by any of its rows by simply clicking your mouse 
on the column title. The sorted column has a caret mark (^) next to the column 
title. 

• The worksheet preserves any carriage returns you enter in the Description  input 
box. 

• Hot key combination for working faster: 

• <CTRL><A> - Same as clicking on the Add at End button. 

• <CTRL><T> - Same as clicking on the Save to Table button. 

• <TAB> - you can use tab to move from field to field. 

• <SPACEBAR> - toggles the checkboxes on and off. 
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• <ARROW KEYS> - can be used to make selections in the drop-down list 
boxes; used in the Date field as well. 
 

Prepare Forms and Documents 
With the worksheets completed, you are ready to prepare any of the available forms, 
documents and pleadings. How you prepare a form or document depends on whether 
it is a static form or a free-flowing document. Here's the difference and how to com-
plete each. 

Static Form - A static form has its fields in the same location. The General Infor-
mation Worksheet is an example. The fields on the General Information Work-
sheet all have a permanently defined x/y coordinate. The Defendant's Last Name 
field, for example, is always against the left margin about half way down the page. 
The location of the Last Name field never varies. When you complete a static form, 
you select it from the Document/Form menu and the form appears on your screen. 
You tab from field to field and complete the form. When you are ready to print it, 
you can do so by using the Print menu on the file menu or clicking on the Print but-
ton on the tool bar near the top of the screen. Below is a list of static forms. 

• General Information Worksheet 
• Financial Disclosure Affidavit 
• Pretrial Statement 
• Parenting Proceeding Affidavit 
• Private Health Insurance Questionnaire 
• Guidelines for Ex-Parte Temporary Restraining Orders 
• Practitioner's Instructions for Service 
• Service Instructions to Clerk of Courts 
 
Documents - Documents, by contrast, are free-flowing. A Separation Agreement is 
a good example. In some cases there are children, sometimes not. Some married 
couples own real estate, others do not. Some marriages involve dividing many as-
sets, others involve none. The existence or lack of these items all contribute to the 
variable length of the document. In some instances, the signature lines might fall on 
page 3. Other, more complicated Separation Agreements, might have their signature 
lines on page 15. Documents are completed by choosing the document from the 
Document/Form menu or using the Main Window . When you select a document, 
it does not appear on your screen like static forms do. Instead, a Document Wizard 
appears and solicits information about the document. When the last page of the Wiz-
ard is complete (or the Finish button is clicked), your word processor appears and 
the completed document is opened. Viewing, editing and printing is all done in your 
word processor and not in FLPA2. Every available choice on the Document/Form 
menu is a document with the exception of the static forms listed above. 
 
Printing 
How you print depends on whether you are printing a static form or free-flowing 
document. Static forms are printed by using FLPA2's Print This Form button or by 
using FLPA2's Print menu. Free-flowing documents are printed from your word 
processor. 
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One More Thing—Setting Defaults 
 
There is one thing you can do to expedite your document processing even more—set 
defaults. To anyone who owns any of our other legal programs, setting defaults 
should be a familiar process. In FLPA2, you can prime or seed new files so that they 
contain General Information Worksheet data (i.e. static form data) and Docu-
ment Wizard answers that don’t change from client to client. 
 
In terms of the General Information Worksheet here are a few examples. Starting 
from the top, there’s the Subtitle field. That’s the line in the case caption between 
the first line and the county line: 
 

IN THE COURT OF COMMON PLEAS 
DOMESTIC RELATIONS DIVISION 

CUYAHOGA COUNTY, OHIO 
 
The subtitle line is the second line—DOMESTIC RELATIONS DIVISION. The 
Agency/Department handling support/arrearages is next. This entry could be 
the “Department of Job & Family Services” or  the “Child Support Enforcement 
Agency.” The County field is another example. If you do 90% of your family law 
practice in one county why not make that county the default. In the event you need 
to, you can always change it easily enough. The four residency checkboxes might be 
other good candidates. Check them by default. If you need to uncheck them for a 
particular client’s file, you can always do so. 
 
The next set of potential defaults would be the Document Wizard answers. Signa-
ture dates at the end of documents and in notary clauses could be primed with under-
scores ( ______________ ). This is just one example of many. The test is that if 
you find yourself making the same entries in different client files, such entries 
should be made defaults. 
 
So how do you make a default? It’s easy. Open the DEFAULT.FL2 file by click-
ing on the File menu’s Open command. It’s just like opening any other file. Once 
you’re in the DEFAULT file type your default answers in the General Information 
Worksheet and any Document Wizards you with to set. Don’t forget to press the 
<TAB> key after each entry. When you’re finished entering your defaults, press the 
Save button. Once you’ve saved your changes, use the File menu’s New command 
to get out of the DEFAULT file. Setting defaults may take some thought and time, 
so be aware that you don’t have to set all the defaults at once. You can open, add to, 
and save the DEFAULT file any time. 
 
Another time-saver could be modifying FLPA2’s document templates. Let’s say that 
you always use certain language in your shared parenting plans. You could use the 
Option menu’s Modify Templates command and insert your special language into 
the Shared Parenting Plan template so that the change would be a permanent part 
of FLPA2 and you would not need to insert that language on a document-by-
document basis. Beware, however, that it’s relatively easy to corrupt a template so 
consult the help file on this topic and be careful. 
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This paper manual is merely an outline of the basics of installation, getting started 
and a tutorial on basic information entry. You can get additional help via the pro-
gram’s Help|Table of Contents menu. This program has context-sensitive help. 
That means that you get help on a specific menu item without searching for that topic. 
Simply highlight the menu command and press �. Other objects on your screen may 
have associated help topics. When in doubt, move focus to the component object and 
press � . 
 
Note. The mouse won’t work to highlight a menu command. You must use the key-
board. To give an example, if you wanted help with the Save As command you 
would press � �  to pull down the File menu, and use the arrow keys to highlight 
the Save As command. With the command highlighted press the � key. 
 
If you’re like us, you might be doubtful as to whether help files can be truly helpful. 
Regardless of  any drawbacks, we found them to have significant benefits over their 
paper counterpart. 
 
Help Is Always There 
When we were at the office, the manual was at home. When were on the computer at 
home, the manual was at the office. On unfortunate occasions, that alone can make 
you lose a day’s work. It never happens with help files. They’re always there. A copy 
for your home computer, and a separate one for the office. Ditto for your laptop! 
When you’re desperate for information, you can always count on its accessibility. 
 
Help Is Hyperlinked, Searchable & Better Indexed. 
We took extra time to develop a logical system of indexing. You should find that a 
help file’s searchability can be a time-saver when you’re looking for a snatch of text. 
The point and click links between key words provide instant information without 
fumbling though page after page looking for something. This non-linear characteris-
tic is part of what makes help files so uniquely useful. 
 
Help Is Up To Date 
Because they are printed in large quantities, paper manuals fall out of synch with last-
minute or late-minor programming changes. Help files, on the other hand, are easier 
to keep current with programming changes because their modification involves no 
additional processing steps to implement (i.e., physical transportation, printing, bind-
ing, etc.). 
 
Paper Fix 
Don’t forget that you can print any help topic by pressing the help window’s Print 
button, or using the menu’s Print Topic command. 
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Checking out these help topics before starting FLPA2 
will reduce the slope of the learning curve. Although 
FLPA2 is relatively straightforward to use, you may 
find that you can be more efficient by becoming ac-
quainted with the help topics listed below. 
 
Setting Defaults 
Some information doesn't’ change from file to file. The county you practice in, for 
example. This help topic shows you how to set this type of information globally so 
you needn’t enter it every time you start a new file. 
 
Modifying Templates 
This help topic explains how you can customize some of the free-flowing documents 
so as to automatically include personalized language. This is another form a global 
change that lets you avoid making additions to documents every time you send them 
to the word processor. 
 
Static Forms vs. Free-Flowing Documents 
You really need to understand the difference between these two if you’re going to use 
FLPA2 successfully and productively. 
 
Overriding 
Occasionally certain static form fields will not be populated with the information you 
want. Overriding these fields is how you can force FLPA2 to do what you want. 
 
Client Worksheets 
These blank worksheets are useful to both your client and you. Don’t overlook their 
utility. 
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